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SECTION 1 INTRODUCTION
USING THIS 
MANUAL

The sections in this manual provide information on 
connecting and operating the 375 Field 
Communicator. 

Section 2: Learning the Basics contains 
information on settings, types of storage, IrDA® 
communication, using ScratchPad, maintenance, 
managing files and storage.
Section 3: HART Functionality contains 
information on starting the HART® application, 
establishing communication with connected HART 
devices, and configuring the HART Application.

Section 4: Troubleshooting provides solutions to 
the most common 375 Field Communicator 
operating problems.

Appendix A: Reference Information provides 
physical, functional, and performance 
specifications.
Appendix B: Approval Information contains 
Hazardous Location Certifications, European 
directive information, and approval drawings.
www.fieldcommunicator.com
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NOTICE
Information on starting the FOUNDATION� fieldbus 
application, working with connected fieldbus 
devices, block lists, diagnostics, and parameter 
functionality will be available in a future release of 
the 375 Field Communicator User�s Manual. 
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SECTION 2 LEARNING THE BASICS
OVERVIEW This section provides instructions on basic features 
and functions of the 375 Field Communicator. It 
also provides instructions on starting, configuring 
the settings, using ScratchPad, maintaining, and 
shutting down the 375 Field Communicator.

SAFETY 
MESSAGES

Procedures and instructions in this section may 
require special precautions to ensure the safety of 
the personnel performing the operation. 
Information that raises potential safety issues is 
indicated by a warning symbol ( ). Refer to the 
following safety messages before performing an 
operation preceded by this symbol. Other warning 
messages can be found in the Troubleshooting 
section of this manual. 

IMPORTANT NOTICE

Ensure the battery pack and the 375 Field Communicator are properly aligned during assembly 
to prevent damage to the connector pins.

IMPORTANT NOTICE

During assembly/disassembly:
Do not pull up on the battery pack as this could damage the power supply connector.
Do not pull up on the System Card as this could damage the card or the System Card socket. 
www.fieldcommunicator.com
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INSTALLING 
THE SYSTEM 
CARD AND 
THE BATTERY 
PACK

1. Place the 375 Field Communicator face down on 
a level, secure surface, see Figure 2-1.

2. Lock the stand into the hanger position. To pivot 
past the stand position, squeeze the stand 
together near the hinge.

Figure 2-1.  . Back side of the 375 Field Communicator

WARNING

Contact with the touch screen should be made by blunt items only, preferably the stylus included 
with the 375 Field Communicator. The use of sharp instruments, such as screwdrivers, can 
cause failure of the touch screen interface. 

WARNING

Initiating a Re-Flash initiates reinstallation of the system software from the System Card. This 
should only be performed under the direction of technical support personnel.

Battery pack 
retaining screws

Battery pack

System Card

Stand Assembly

Battery pack charge 
indicator button
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3. With the battery pack removed, place the 
System Card, with the card contacts facing up, 
on the main unit System Card guide ribs (located 
directly below the battery pack connector). Insert 
the System Card until it is firmly in place.

4. With the main unit still face down, ensure the 
tops of the two battery pack retaining screws are 
flush with the top of the battery pack.

5. Install the battery pack by aligning the sides of 
the battery pack and main unit and carefully 
sliding the battery pack forward until it is secure. 
If the battery pack and main unit are not properly 
aligned, the connector pins can be damaged.

6. Tighten the two battery pack retaining screws 
until they are secure (do not overtighten). The 
tops of the screws should now be close to flush 
with the stand groove.

STARTING UP 
AND 
SHUTTING 
DOWN

Prior to using the 375 Field Communicator without 
the power supply, fully charge the battery pack. A 
full charge is indicated by a solid green light on the 
charger/power supply. Charging may take up to 
two hours. The 375 Field Communicator may be 
used while charging. Before operating the 375 
Field Communicator, ensure:
� The 375 Field Communicator is not damaged.
� The battery pack is fully seated.
� All screws are sufficiently tightened.
� An Expansion Module (EM) or Expansion Port 

Plug is in place.
� The communication terminal recess is free of dirt 

and debris.
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Starting the 
375 Field 
Communicator

Press and hold the on/off key until the Multifunction 
LED flashes to indicate the unit is powering 
(approximately two seconds). See Figure 2-2 for 
on/off key location.
During start-up, the 375 Field Communicator will 
automatically perform any software upgrades 
available on the System Card. Once complete, the 
375 Main Menu will be displayed. After starting the 
375 Field Communicator, you can choose to:
� Launch the HART or FOUNDATION fieldbus 

Applications
� Configure/view Settings
� Listen for PC
� Launch the ScratchPad application

Shutting down While applications are open, the on/off key is 
disabled. You must exit to the 375 Main Menu 
before using the on/off key. To shut down the 375 
Field Communicator press and hold the on/off key 
until the display turns off (approximately three 
seconds). 
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BASIC 
FEATURES 
AND 
FUNCTIONS

Figure 2-2.  375 Field Communicator diagram

Backlight 
adjustment key

IrDA interface
(top)

Touch screen
display

HART and fieldbus 
communication 
terminals (top)

Expansion port
(side)

Enter key

Function key 
(for multiple-key 
combination functionality)

Alphanumeric keypad

Power supply/charger 
connection (side)

Multifunction LED

On/off key

Navigation keys
(four arrow keys)

Tab key

Stylus 
(back)
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Using the 
keypad

The 375 Field Communicator keypad and touch 
screen have nearly total functional redundancy. 

On/off key
The on/off ( ) key is used to power on and off the 
375 Field Communicator. 
You can also power the 375 Field Communicator 
off by simultaneously pressing the backlight 
adjustment key and the function key until the 
display turns off. This is a mechanism by which the 
power down is accomplished in the hardware 
(similar to removing the power to a PC using a 
switch). This is not the recommended way of 
shutting off the 375 Field Communicator. 

Four arrow navigation keys
Four arrow navigation keys allow you to move 
through the menu structure of the applications. 
Press the right arrow navigation key ( ) to 
navigate further into the menu.

Enter key
The enter ( ) key allows you to perform the 
focused item or to complete an editing action and 
does not navigate you through the menu structure. 
For example, if you have the Cancel button in 
focus (highlighted) when you push the enter key, 
you will be choosing to cancel out of that particular 
window. 

Tab key
The tab ( ) key allows you to move between 
selectable controls.
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Alphanumeric keypad
The alphanumeric keypad allows you select to 
both letters, digits, and other characters, such as 
punctuation marks. It can perform a selection of 
options and data entry in either numeric or 
alphanumeric modes. The 375 Field 
Communicator will automatically determine the 
mode depending upon the input necessary for the 
particular field. 

When in alphanumeric mode, to enter text press 
the desired keypad button in quick repetition to 
scroll through the options to achieve the 
appropriate letter or number. For example, to type 
the letter Z, press the 9 key quickly four times, see 
Figure 2-3.

Figure 2-3.  Keypad button functionality example 

Backlight adjustment key
The backlight adjustment ( ) key allows you to 
adjust the intensity of the display. There are four 
different settings. Intensity impacts the battery life 
of the 375 Field Communicator. Expect a shorter 
battery life for higher intensities, see �Backlight� on 
page 2-10 for settings.
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Function key
The function ( ) key allows you to enable 
alternate functionality on select keys. The grey 
characters on the keys indicate the alternate 
functionality. When enabled, the orange 
multifunction LED light will appear and an 
indication button can be found on the SIP. If the 
function key is enabled, press the key again to 
disable the functionality.

The alternate function on the Tab and 
alphanumeric 5 key (insert) will be activated in 
future releases of the 375 Field Communicator.

Multifunction LED 
The multifunction LED allows you to recognize 
when the 375 Field Communicator is in various 
states, see Table 2-1.

Table 2-1.  Multifunction LED

Using the 
touch screen

The touch screen display allows you to select and 
enter text by touching the window. Tap the window 
once to select a menu item or to activate a control. 
Double-tap to move further into the menu level.

NOTE
All instructions in this manual are written for the 
touch screen.

Multifunction LED Processing indication 

Green The 375 Field Communicator is on.

Flashing Green The 375 Field Communicator is in 
power saving mode. The display is off.

Green and Orange The Function key is enabled.
Flash green and orange The on/off button has been held down 

long enough for power up.
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The touch screen should be contacted by blunt 
items only, preferably the stylus included with the 
375 Field Communicator. The use of sharp 
instruments, such as screwdrivers, can cause 
failure of the touch screen interface. Repair of the 
touch screen requires replacement of the entire 
375 Field Communicator display assembly, which 
is possible only at an authorized service center. 

Use the back arrow button ( ) to return to the 
previous menu. Use the terminate button ( ) in 
the upper right corner of the touch screen to end 
the application.

Using the Soft Input Panel (SIP) keyboard
The SIP keyboard allows for alphanumeric input 
using the touch screen. The SIP keyboard detects 
when you need to enter characters and will appear 
automatically as required. 

VIEWING THE 
375 MAIN 
MENU

The 375 Main Menu allows you to run the HART 
application, run the Settings menu, communicate 
with your PC, and launch the ScratchPad 
application.

Figure 2-4.  375 Main Menu
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Running the 
HART 
application

From the 375 Main Menu double-tap HART 
Application to run the HART application. On 
startup, the HART Application will automatically 
poll for devices.

Running the 
Settings menu

From the 375 Main Menu double-tap Settings to 
view the Settings menu.The Settings menu allows 
you to set preferences for the 375 Field 
Communicator. The Settings menu also allows you 
to view system properties and license information.

To adjust the 375 Field Communicator settings:
1. From the 375 Main Menu select Settings.
2. Select the desired setting from the Settings 

menu.

About 375
About 375 allows you to view the software property 
revisions of your particular 375 Field 
Communicator. If you need to call technical 
support, have the System Software version, 
Communication and Diagnostic Circuitry (CDC) 
version, and the Operating System version on 
hand. 

Launching the RE-FLASH initiates the 
reinstallation of the system software from the 
System Card. This should only be performed under 
the direction of technical support personnel. 

Backlight
The backlight setting allows you to adjust the 
intensity of the display. To adjust the backlight, 
drag the slider left to right. When you find an 
appropriate backlight setting select OK for this 
session only, SET DEFAULT to retain this setting 
upon start up, or CANCEL to exit without changes.
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Clock
The clock setting allows you to set the date and 
time on the 375 Field Communicator. Configure the 
date by using the drop down menu. To configure 
the time, highlight the appropriate time field and 
use the arrows to scroll through values until you 
find the correct time. Select OK to close. 

Contrast
The contrast setting allows you to adjust the 
lightest and darkest areas on a display screen.

To adjust the contrast, drag the slider left or right. 
The window will automatically adjust the contrast 
as you move the slider. When you find an 
appropriate contrast setting select OK for this use 
only, SET DEFAULT to retain this setting upon 
start up, or CANCEL to exit without changes.

NOTE
Contrast can be effected by temperature.

Event capture
The event capture setting allows you to turn on 
and off the event captures and also allows you to 
delete event capture (.rec) files. An event capture 
is a log of communication, input, and screen output 
that occurs between the 375 Field Communicator 
and a device. 
1. Activate event capture in the settings menu by 

tapping the desired radio button. The radio 
button will be highlighted white when selected. 
To delete an event capture tap the DELETE 
EVENT FILE button. 

With event capture enabled, starting the HART 
application will activate an event capture dialog 
box for you to enter a file name. Enter the name 
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and tap OK. The file will be saved to a default 
location.

NOTE
While event capture is enabled, device warning 
messages will not appear. 

Event captures are helpful in troubleshooting. 
1. Create an event capture.
2. Transfer the event capture to a PC with the 

Programming Utility, see Programming Utility 
Help for more information.

3. Email the event capture to technical support 
personnel who will then be able to view the 
specific communication.

License
Licensing can be viewed when you turn on the 375 
Field Communicator and in the license settings 
menu. The license setting allows you to view the 
license on the System Card. The HART application 
license is standard in every 375 Field 
Communicator. Other licenses available include 
the FOUNDATION fieldbus application and Easy 
Upgrade option. Unlicensed features cannot be 
accessed. 

Memory
The memory setting allows you to view the total 
memory storage and available free space in the 
System Card, Internal Flash, RAM, and Expansion 
Module (if installed). 

Power
The power setting allows you to specify power 
management and to view battery/charge status.To 
specify the power management settings select the 
time interval from the drop down menus.
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The power saving mode will turn off the backlight, 
the display and reduce power consumption to a 
minimum. The green multifunction LED light will 
flash while in power saving mode. To exit out of the 
power saving mode press any key or tap the touch 
screen. The 375 Field Communicator will return to 
the previously running mode.

The auto-off will turn off the 375 Field 
Communicator after the specified duration of 
inactivity. 

NOTE
The auto-off functionality will be disabled 
automatically during certain operations to prevent 
the unintentional loss of data.

When you determine an appropriate power 
management setting select OK for this session 
only, Set Default to retain this setting upon start 
up, or Cancel to exit without changes. 

Power supply is indicated at the bottom of the 
screen. When on battery power, a percent charge 
remaining bar will be present. A message will 
appear when on external power.

Touch screen alignment
The touch screen alignment setting allows you to 
calibrate the touch screen with the display. Tap the 
cross hairs firmly and accurately at each location 
on the window. The target will continue to move 
until the touch screen is aligned. Touch screen 
alignment will be retained upon start up.

Exit to the 375 Main Menu
Double-tap Exit to 375 Main Menu if you want to 
return to the 375 Main Menu.
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Communicating 
with a PC

IrDA communication with PCs
The 375 Field Communicator communicates with 
PCs using infrared technology. IrDA is the only PC 
interface supported for the transfer of device 
descriptions, software updates, configurations, 
event captures, and ScratchPad files.

IrDA communication can either be built into the PC 
or provided through an adapter such as a USB to 
IrDA adapter or a serial to IrDA adapter. Refer to 
your IrDA manual for operating instructions.

Throughput for infrared communications with the 
375 Field Communicator is approximately 
4 kilobytes/second. Maximum recommended 
distance between the IrDA and PC is 18 inches.

Listen For PC 
In Listen for PC, the 375 Field Communicator is 
under the control of a PC application for 
transferring data and managing device 
configurations. The PC application could be one of 
the following:
� Emerson Process Management AMS (version 

6.2 or higher), software for managing 
instrumentation and valves in a process plant. 
Currently, AMS only supports HART 
configurations. In the future, it will also support 
FOUNDATION fieldbus configurations.

� 375 Field Communicator Programming Utility, a 
PC-based application for sending files to and 
receiving files from a 375 Field Communicator.
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To enter Listen for PC mode:
1. From the 375 Main Menu, select Listen for PC.
2. Align the 375 Field Communicator IrDA interface 

with the PC IrDA interface. 
3. Complete the necessary transfer(s) using the 

Programming Utility or AMS, see the 
Programming Utility Help for more information.

4. Tap EXIT to close the Listen for PC application.

If new system software was downloaded to the 375 
Field Communicator System Card, an update of 
the Internal Flash will occur. 

Transferring HART configurations using AMS
A licensable AMS (version 6.2 or higher) option 
lets you use the 375 Field Communicator with 
AMS. 
1. Align the 375 Field Communicator IrDA interface 

with the PC IrDA interface then enter Listen for 
PC mode. A 375 Field Communicator icon will 
appear in AMS to indicate that all configurations 
from the 375 Field Communicator can be 
accessed. 

2. In AMS double-click the 375 Field 
Communicator icon. The Expansion Module and 
Internal Flash folders are displayed. Once all of 
the configuration files are displayed perform 
your tasks with AMS.

Programming Utility
To add Device Descriptions (DDs) or system 
software upgrades you will need to have a System 
Card with the Easy Upgrade option. For more 
details see the Programming Utility Help.

All 375 Field Communicators come with the basic 
ability to transfer event captures and text files. 
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Using the 
ScratchPad 
application

From the 375 Main Menu double-tap ScratchPad 
to run the ScratchPad application. ScratchPad is a 
text editor that you can use to create, open, edit 
and save simple text (.txt) documents. You are 
able to transfer .txt files between a PC and the 375 
Field Communicator using the Programming Utility. 
ScratchPad only supports very basic formatting. 
You can also launch the ScratchPad application 
from within the HART application by tapping the 
ScratchPad ( ) icon in the upper right corner of 
the display. This will automatically open the 
ScratchPad application.
Once ScratchPad is launched you can perform the 
following operations. 

Figure 2-5.  Open blank document in ScratchPad
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Create a new document
From the Main Page in the ScratchPad application, 
tap the NEW button. An empty text window and 
SIP keypad will appear. You are now ready to enter 
text into your new document.

A new document can also be created within 
ScratchPad by tapping the New ( ) icon in the 
toolbar or by selecting File > New from the menu. 

Open an existing document
1. From the Main Page in the ScratchPad 

application, select the desired file located under 
File Name.

2. Tap the OPEN button. A text window and the 
SIP keypad will appear. You are now ready to 
edit your document. 

You can also open a document by selecting File > 
Open from the menu bar or by tapping the Open 
( ) icon in the toolbar. 

Enter text 
Using the stylus, tap the desired letters from the 
SIP keyboard. Using the keypad, press the desired 
keypad button in quick repetitions to display the 
appropriate letter or number. 

Select text
Drag the stylus over the desired text to highlight, or 
to select all of the text in the document tap Edit > 
Select All....
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Cut text
1. Select the text to be cut.
2. Tap Edit from the menu bar.
3. Tap Cut from the Edit menu.

You can also cut text by selecting text and tapping 
the Cut ( ) icon in the toolbar. 

Copy text
1. Select the text to be copied.
2. Tap Edit from the menu bar.
3. Tap Copy from the Edit menu.

You can also copy text by selecting text and 
tapping the Copy ( ) icon in the toolbar.

Paste text
1. Copy the text to be pasted. 
2. Tap Edit from the menu bar.
3. Tap Paste from the Edit menu.
You can also paste text by copying the text to be 
pasted and tapping the Paste ( ) icon in the 
toolbar.

Undo text
1. In your document, tap Edit from the menu bar.
2. Tap Undo from the Edit menu.

Save a document
1. In your document, tap File from the menu bar.
2. Tap Save from the File menu.
3. Type the file name in the dialog box if your 

document is new.
4. Tap OK.
You can also save a document by tapping the 
Save ( )icon in the toolbar.
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Save a copy 
To save a copy of the current document under 
another name:
1. In your document, tap File from the menu bar.
2. Tap Save As... from the File menu.
3. Type the copy file name in the dialog box.

Delete a document
There are three options for deleting a ScratchPad 
document:
Option 1
1. From the Main Page in ScratchPad, select the 

file to be deleted. 
2. Tap DELETE.
3. A warning will appear telling you that the 

selected file will be permanently deleted. If you 
are sure you want to delete this file tap Yes.

Option 2
1. To delete from your document, tap File > Delete.
2. From the Delete File Page, tap the desired file to 

be deleted.
3. Tap OK.
4. A warning will appear telling you that the 

selected file will be permanently deleted. If you 
are sure you want to delete this file tap Yes.

5. Tap EXIT when you are finished deleting files.

Option 3

Delete the .txt file from the Programming Utility. 
See the Programming Utility Help for more 
information. 

Exiting ScratchPad
1. In your document, tap File from the menu bar.
2. Tap Exit from the File menu.
3. Tap the EXIT button from the Main Page.
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MANAGING 
STORAGE

The 375 Field Communicator system management 
and storage allows you to view the types of 
storage, run IrDA communication, transfer 
configurations, and operate the Programming 
Utility.

Types of 
storage

The 375 Field Communicator memory consists of 
four components:
1. Internal Flash�32MB non-volatile RAM. The 

Internal Flash memory can store:
� Twenty-five HART configurations (The optional 

Configuration Expansion Module (spare part 
number 00375-0043-0001) will allow you to 
store more configurations if needed.)

� HART event captures, FOUNDATION fieldbus 
statistics, and user generated text files

� 375 Field Communicator system software
2. System Card (SC)�an internal Secure Digital 

Card with non-volatile Flash memory. A copy of 
installable 375 Field Communicator application 
software exists on every System Card. The 
System Card also stores all HART and 
FOUNDATION fieldbus Device Descriptions.

3. RAM�32MB used only for program execution
4. Expansion Module (EM)� an optional 

removable memory card that snaps into the 
Expansion Port on the side of the 375 Field 
Communicator. e.g. The Configuration 
Expansion Module can store HART device 
configurations. 
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MAINTENANCE Any maintenance, repair, or replacement of 
components not listed below must be performed by 
specially trained personnel at authorized service 
centers. You can perform common maintenance 
procedures on the 375 Field Communicator, as 
described below: 
� Cleaning the exterior. Use only a dry lint-free 

towel or dampen the towel with a mild soap and 
water solution.

� Charging, removing, and replacing the battery 
pack

� Removing and replacing the System Card 
� Removing and replacing the Expansion Module 

or Expansion Port Plug
� Removing and replacing the stand assembly
� Ensuring that all exterior screws are sufficiently 

tightened
� Ensuring that the Communication Terminal 

recess is free of dirt and debris (does not require 
disassembly).

Battery 
Information

Checking the charge remaining
Use the Settings menu to check the charge 
remaining, see �Power� on page 2-12.

You can also check the battery charge remaining 
before you insert a spare battery pack. 
1. Remove the battery pack, see �Removing the 

System Card and battery pack� on page 2-22.
2. Turn the battery pack over and press the battery 

pack charge indicator button. The indication 
lights will illuminate based upon the amount of 
charge remaining in the battery. Each light 
represents 20 percent of charge remaining. The 
battery is fully charged when all of the indicator 
lights are illuminated.



Learning the Basics2-22
Charging the battery
The battery can be charged while attached to the 
375 Field Communicator or charged separately. 
The indication light on the charger will be green 
when fully charged, amber when charging, cycle 
between amber and green when pulse charging, 
and red if it is unable to charge. Do not attempt to 
charge the battery pack in hazardous areas. 
Charge the 375 Field Communicator battery:
1. Plug the recharger/power supply into a power 

outlet.
2. Plug the power supply/charger connection into 

the 375 Field Communicator. The 375 Field 
Communicator is fully operable while the battery 
is recharging.

Removing the System Card and battery pack
Remove the System Card and battery pack: 
1. Place the 375 Field Communicator face down on 

a level, secure surface.
2. Loosen the two battery pack retaining screws 

until the top of each screw is flush with the top of 
the battery pack.

3. Slide the battery off the main unit. Do not pull up 
on the battery pack as this could damage the 
power supply connector.

4. Grasp the System Card and slide it straight out 
of the main unit. Do not pull up on the System 
Card as this could damage the card or the 
System Card socket. 

Running a self 
test

There is no need, nor is it possible, to perform a 
manual self test with the 375 Field Communicator. 
Testing features are done automatically. A warning 
message will occur if a fault condition is found 
during these tests.
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Working in an 
Intrinsically 
Safe (IS) area

The battery pack can be replaced in Intrinsically 
Safe areas. The Expansion Module can be 
installed in hazardous locations while the 375 Field 
Communicator is still running. 

Waste 
disposal

If it ever becomes necessary to discard any part(s) 
of the 375 Field Communicator, adhere to the 
waste-disposal regulations applicable in your 
locality.
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USER�S MANUAL
00375-0047-0001, Rev AA
July 2003 375 FIELD COMMUNICATOR
SECTION 3 HART FUNCTIONALITY
OVERVIEW This section provides instruction on basic HART 
functionality of the Model 375 Field Communicator. 
As they become available, the HART Field 
Communicator menu trees will be located online at 
www.fieldcommunicator.com. 

SAFETY 
MESSAGES

Procedures and instructions in this section may 
require special precautions to ensure the safety of 
the personnel performing the operation. 
Information that raises potential safety issues is 
indicated by a warning symbol ( ). Refer to the 
following safety messages before performing an 
operation preceded by this symbol. Other warning 
messages can be found in the Troubleshooting 
section of this manual. 

WARNING

If you choose to ignore all field device status messages, every message from nuisance to critical 
will be ignored. 

WARNING

Voltage measurements are for reference purposes only. Do not make critical process control 
decisions based upon this voltage.
www.fieldcommunicator.com
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BASIC 
FEATURES 
AND 
FUNCTIONS

Interpreting the HART icon
A beating hollow heart icon is displayed when the 
375 Field Communicator is communicating with a 
live HART device ( ). A solid beating heart will 
replace the hollow heart icon when communicating 
to a HART loop with a device in burst mode. The 
HART logo is displayed during periods when 
communication is not occurring.

NOTE
This is common when only static parameters are 
listed.

STARTING 
THE HART 
APPLICATION

To start the HART application:
1. Turn on the 375 Field Communicator. The 375 

Main Menu is displayed with HART as the 
default application.

2. Double-tap HART Application. If a live HART 
device is connected to the 375 Field 
Communicator, the HART Application main 
menu will be displayed automatically with key 
parameters from the connected device. If a 
device is not connected, the HART Application 
main menu is displayed after a few seconds. To 
navigate back to the 375 Main Menu press the 
back arrow button. From the HART Application 
main menu you can choose Offline, Online, or 
Utility functions. The rest of this section will 
guide you through the HART Application menus 
and functions.

Using Fast Key 
sequences

The Fast Key sequence is a sequence of 
numerical button presses, corresponding to the 
menu options that lead you to a given task. The 
Fast Key sequences are identical to the 275 HART 
Communicator. See your field device 
documentation for fast key sequence options.
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Setting up Hot 
Key options

The Hot Key menu is a user-definable menu that 
can store shortcuts for up to 20 of your most 
frequently performed tasks. For example, if you 
change device tags and damping often, you can 
add options for these functions to the Hot Key 
menu. Once you are Online the Hot Key will 
automatically appear in the toolbar. To add a 
custom option to the Hot Key menu:
1. With the Online menu or any of the submenus 

open, select the option you want to add to the 
Hot Key menu.

2. Tap and hold the Hot Key ( ). The Hot Key 
Configuration window shows the new option you 
are adding.

3. Tap ADD.
4. Tap ALL to add the Hot Key option for all 

devices supported by the Communicator, or tap 
ONE to add the Hot Key option only for the 
device type to which you are currently 
connected.

5. If the message �Mark as read only variable on 
Hot Key menu� displays, choose one of the 
following:

� YES: The variable for this option is read-only, 
meaning users can view but not change its 
value.

� NO: You can view as well as change the value 
for this variable.

6. Respond to the message �Display value of 
variable on Hot Key menu?� by choosing one of 
the following:

� YES: The value of this variable will appear on 
the Hot Key menu.

� NO: The Hot Key menu will show the name of 
the variable but not its value.
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7. Tap the EXIT button on the Hot Key 
Configuration window to return to the original 
menu. The new option is added to the Hot Key 
menu.

Executing Hot 
Key options

To use a Hot Key option, you must first properly 
connect the 375 Field Communicator to a device. 
You can access the Hot Key menu from any online 
window. To use a Hot Key option:
1. Connect the 375 Field Communicator to a HART 

loop or device.
2. Tap the Hot Key. The Hot Key menu is 

displayed. 
3. Double-tap the desired option.

Removing Hot 
Key options 
one at a time

To remove individual Hot Key options:
1. Tap and hold the Hot Key ( ). The Hot Key 

Configuration window will appear.
2. Select the menu option you want to remove.

NOTE
Range Values is a predefined option and cannot 
be removed. It provides quick access for viewing 
or changing the range for a device.

3. Tap the DEL button.
4. When you are done, tap EXIT to close the Hot 

Key Configuration window.

Removing all 
Hot Key 
options

To remove all Hot Key options currently defined:
1. From the HART main menu, double-tap Utility.
2. From the HART Utility menu, double-tap 

Configure HART Application.
3. From the Configure HART Application menu, 

double-tap Storage Cleanup.
4. From the Storage Cleanup menu, double-tap 

Hot Key Menu.
5. Tap YES if you are sure you want to delete all 

the items from the Hot Key menu.
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WORKING 
OFFLINE

The Offline menu allows you to create offline 
configurations, view and change device 
configurations stored on the 375 Field 
Communicator.

There are two types of configurations: device 
configuration and user configuration. A HART 
configuration created from a HART device will 
initially be saved as a device configuration. A 
HART configuration created Offline will be saved 
as a user configuration. A HART configuration 
transferred to a 375 Field communicator from 
another program will be saved as a user 
configuration. Editing a device configuration within 
the 375 Field Communicator will change it to a 
user configuration. 

In the 375 Field Communicator, there is no concept 
of partial or standard configurations. All 
configurations are full configurations.

Creating new 
configurations 
Offline

Creating a new configuration allows you to create 
a user configuration for a specific device type and 
revision. To create a new HART device 
configuration while working offline:
1. From the HART Application main menu, 

double-tap Offline.
2. From the Offline menu, double-tap New 

Configuration. The manufacturers with device 
descriptions installed on the 375 Field 
Communicator are listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

5. Double-tap the desired device revision.
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6. If a warning appears, thoroughly read the 
warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new user 
configuration.

7. Mark the configurable variables you want sent to 
the HART device. Double-tap Mark all > OK to 
have all variables marked. Double-tap Unmark 
all > OK to clear the marks from all variables. A 
�+� symbol indicates a mark to send. A �*� 
symbol indicates a parameter has been 
edited.To mark and edit variables individually:
a.Double-tap Edit individually to configure 

specific variables before sending them to a 
device.

b.Scroll through the list of variables and select 
the variable you want to mark or edit.

c.To change the value for the selected variable, 
tap EDIT, change the value, and tap ENTER.

d.To mark the selected variable, tap MARK. A 
�+� symbol indicates a mark to send. A �*� 
symbol indicates a parameter has been edited.

e.Repeat steps b through d for other variables as 
necessary and tap EXIT when you are 
finished.

8. To save a new configuration, double-tap Save 
as... (The SAVE button will automatically bring 
you to the Save as... menu.)
a.To change the location where the configuration 

is saved, double-tap Location, select an 
option, and tap ENTER.

b.To specify a name for the configuration, 
double-tap Name, enter the name, and tap 
ENTER.

c.Tap SAVE. 
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Opening saved 
configurations 
Offline

Once opened, a saved configuration allows you to 
edit, copy to, send, delete, rename, and compare 
to other saved configurations. To open a saved 
configuration:
1. From the HART Application main menu, 

double-tap Offline.
2. From the Offline menu, double-tap Saved 

Configuration.
3. Double-tap the storage location from where you 

saved the configuration�Internal Flash 
Contents or Configuration Expansion Module 
Contents.

4. Double-tap the desired configuration to open the 
menu selection.

The FILTR button opens a menu that provides 
both sort and tag filter options. These options 
allow you to customize your view of saved 
device configurations. 

Sort allows you to group and display device 
configurations according to your choice of name, 
tag, or descriptor. 

Tag Filter allows you to customize your group for 
viewing according to what you entered with Sort 
by picking characters from the device name, tag, 
or descriptor. 

When setting up a filter, you can use two special 
characters: the period (.) and the asterisk (*). 
The period replaces a single character of any 
value. The asterisk is used to represent a string 
of alphanumeric characters of any value.

For example, if you want to list all configurations 
that have a tag or name of P - 001 to P - 300. 
You would enter �P - *� in the filter. If you want to 
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list configurations that have a tag or name that 
begins P- 0 and ends with a 7, set the filter to 
P - 0.7.

The XPAND button allows you to view the tag, 
manufacturer, device type, descriptor, and the 
configuration type. Tap CMPRS to return to the 
previous compressed screen.

Choose from the following menu options:

Edit a saved configuration Offline
Edit a saved configuration while working offline:
1. From the Saved Configuration menu, double-tap 

Edit.
2. If a warning appears, thoroughly read the 

warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new unit 
configuration.

3. Mark the configurable variables you want saved 
in the HART configuration. Double-tap 
Mark all > OK to have all variables marked. 
Double-tap Unmark all > OK to clear the marks 
from all variables. To mark and edit variables 
individually:
a.Double-tap Edit individually to configure 

specific variables before sending them to a 
device.

b.Scroll through the list of variables and select 
the variable you want to mark or edit.

c.To change the value for the selected variable, 
tap EDIT, change the value, and tap ENTER.

d.To mark the selected variable, tap MARK. A 
�+� symbol indicates a mark to send. A �*� 
symbol indicates a parameter has been edited.

e.Repeat steps b through d for other variables as 
necessary.

4. Tap SAVE to return to the Contents menu.
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Copy a saved configuration Offline
Copy to... allows you to copy a saved configuration 
to a new storage location.
1. From the Saved Configuration menu, double-tap 

Copy to....
2. Choose the storage location from which you 

want to open the configuration�Internal Flash 
or Configuration Expansion Module and tap 
ENTER.

3. Double-tap Name and enter the name of the 
configuration.

4. Tap SAVE to copy to a new location.

Send a saved configuration Offline
Send allows you to send the selected configuration 
to a connected device. From the Saved 
Configuration menu, double-tap Send. The 375 
Field Communicator will then send the 
configuration to a connected device that is 
compatible with the configuration.

Delete a saved configuration Offline
Delete allows you to remove configurations one at 
a time. To delete a configuration from the 375 Field 
Communicator storage:
1. From the Saved Configuration menu, double-tap 

Delete.
2. Tap Yes to confirm the deletion.
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Rename a saved configuration Offline
Rename allows you to change the name of a 
saved configuration. To rename a saved HART 
configuration:
1. From the Saved Configuration menu, double-tap 

Rename.
2. Double-tap the file you want to rename.
3. Enter the new file name and tap ENTER.
4. Tap SAVE.

Compare two saved configurations Offline
Any two configurations can be compared. 
However, in order to compare two configurations of 
the same field device, the following conditions 
must be met:
� Device type (including manufacturer), device 

revision, and DD revision must match exactly. A 
dialog box will appear if the comparison is 
different, however, you will not be told the 
differences.

� Configurations can only be compared against 
other configurations containing the same set of 
variables. The 375 Field Communicator notifies 
you if this condition is not met.

The format of data storage must match exactly. 
The 375 Field Communicator notifies you if this 
condition is not met.
1. From the Saved Configuration menu, double-tap 

Compare.
2. Choose the storage location�Internal Flash or 

Configuration Expansion Module and tap 
ENTER.

3. Double-tap Name to select the configuration file.
4. Double-tap the desired file to compare.
5. Tap COMP to compare the configurations.
6. Tap OK when you are finished reading the 

window.



HART Functionality 3-11
WORKING 
ONLINE

The online mode displays data for the HART 
device to which you are connected. The Online 
menu displays critical, up-to-date process 
information that is continuously updated, including 
device setup, primary variable (PV), analog output 
(AO), lower range value (LRV), and upper range 
value (URV). For information about intrinsically 
safe connections see Appendix B �Approval 
Information�.

A HART configuration created from a connected 
HART device will initially be saved as a Device 
Configuration. Editing a Device Configuration 
within the 375 Field Communicator will change it to 
a User Configuration. 

The 375 Field Communicator can communicate 
with a transmitter from the control room, the 
instrument site, or any wiring termination point in 
the loop.

Connecting to 
a HART loop

Connect the 375 Field Communicator with the 
appropriate connectors in parallel with the 
instrument or load resistor. The HART connections 
are not polarity sensitive.

In order for the 375 Field Communicator to function 
properly, a minimum of 250 ohms resistance must 
be present in the HART loop. 

NOTE
Dynamic variables shown while online represent 
the digital data being sent from the device. 
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There are three terminals on the top of the 375 
Field Communicator. Two of them are red and one 
of them is black. Each red terminal is a positive 
connection for its protocol. The black terminal is a 
common shared by both protocols. There is an 
access door to ensure that only one pair of 
terminals is exposed at any one time, see Figure 
3-1. There are several markings to indicate which 
pair of terminals is for which protocol. 

Figure 3-1.  HART terminal access door

HART Terminal Markings
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Connecting to 
a HART loop

The following diagram illustrates how to connect 
the 375 Field Communicator to a HART loop:

Connecting 
directly to a 
HART device

The following diagram illustrates how to connect 
the 375 Field Communicator directly to terminals of 
a HART device:

HART compatible 
device
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mA Power 
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+
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+
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Connecting 
the optional 
250-Ohm load 
resistor

The following diagram illustrates how to connect 
the optional 250-ohm resistor. Attaching a resistor 
is necessary if less than 250 ohms resistance is 
present in the HART loop. 

To temporarily install the optional 250-ohm load 
resistor:
1. Insert the load resistor into the lead set jacks.
2. Open the loop to allow connection of the resistor 

in series in the loop.
3. Close the loop using the lead set connectors.

VIEWING THE 
ONLINE MENU

The Online menu is the first menu to appear when 
connecting to a HART compatible device. It is 
structured to provide important information about 
the connected device. This menu displays critical, 
up-to-date device information including primary 
variable, analog output, lower range value, and 
upper range value. See your field device user�s 
manual for more information.

Optional 
250-Ohm Load 
Resistor

HART compatible 
device

Power
Supply

�+

�

+
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Because of the important information provided in 
the Online menu, some menus provide instant 
access to this window. When access is available, 
the HOME button appears to return you to the 
Online menu.

Figure 3-2.  Online menu example

Once you have made changes to the parameters, 
you may send them to the device. An asterisk will 
appear next to the parameter name of any un-sent 
item.

The configuration parameters for devices vary 
widely from device to device and are defined in the 
device description. Refer to your field device user�s 
manual for more information. To view process 
information for a connected device:
1. Connect the 375 Field Communicator to a HART 

loop or directly to the device.
2. Push the on/off button to turn on the 375 Field 

Communicator.
3. Double tap HART Application. The Online main 

menu will be displayed automatically.
4. You can view more information about these 

parameters by choosing the following Online 
menu options:
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Viewing the 
Device Setup 
submenu

The Device Setup menu accesses every 
configurable parameter of the connected device. 
Double-tap Device setup to view the process 
variables, diagnostics and service, basic setup, 
detailed setup, and review:

Process Variables (PV)
The PV menu lists all process variables and their 
values. Process variables are continuously 
updated when this screen is displayed. 

Diagnostics and service
The Diagnostics and Service menu offers device 
and loop tests as well as calibration options. The 
diagnostics and service operations that are 
available vary widely from device to device and are 
defined in the device description.
Test device menu lists the status as well as self 
and master test of the device. Test device initiates 
a diagnostic routine at the device and can report 
an electronics failure, as well as other failures that 
can affect performance. 

Loop test is used to set the output of the device at 
a specified analog value, and may be used to test 
the integrity of the loop and the operation of 
indicators, recorders, or similar devices in the loop. 

Calibration is used to perform such operations as 
performing a sensor trim, D/A trim, and scaled D/A 
trim.

Basic setup
The Basic setup menu provides quick access to a 
number of configurable parameters including tag, 
unit, range values, and damping. 
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The options available in the Basic setup menu are 
the most fundamental tasks that can be performed 
with a given device. These tasks are a subset of 
the options available under the Detailed setup 
menu.

The Tag alphanumeric identifies a specific device. 
Changing units affects the engineering units that 
are displayed. Reranging changes the analog 
output scaling. Changing damping effects the 
response time of the transmitter and is often used 
to smooth the output when there are rapid input 
variations.

Detailed setup
The Detailed setup menu provides access to every 
editable device parameter and all device functions. 
The Detailed setup menu varies widely from one 
HART compatible device to another. Functions in 
this menu can include tasks such as 
characterization, configuration, and sensor and 
output trims.

Review 
The Review menu lists all of the static parameters 
read from the connected device, including 
information about the device and sensor setup and 
limitations. It also includes information about the 
connected device such as tag, materials of 
construction, and device software revision.

Primary 
Variable (PV)

The Online menu displays critical process 
information that is continuously updated. If the 
primary variable and related engineering units are 
too long, they will not appear on the Online menu. 
Double-tap PV to view when the primary variable 
and the related engineering units truncated on the 
Online menu.
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Analog Output 
(AO)

The analog output is the signal on the 4�20 mA 
scale that corresponds to the primary variable. 
This is a digital value sent from the field device. 
Double-tap PV AO to view when the analog output 
and its related engineering units are truncated on 
the Online menu.

Lower Range 
Value (LRV)

Double-tap PV LRV to view when the lower range 
value and its related engineering units are 
truncated on the Online menu.

Upper Range 
Value (URV)

Double-tap PV URV to view when the upper range 
value and its related engineering units are 
truncated on the Online menu.

VIEWING THE 
UTILITY MENU

The Utility menu allows you to set the polling 
option, change the number of ignored status 
messages, view the available Device Descriptions, 
perform a simulation, and view HART diagnostics.

Configuring 
the HART 
application

Changing the HART polling option
Use the HART polling option to configure your 375 
Field Communicator to automatically search for all 
or specific connected devices. Most HART device 
installations contain one device per loop and the 
device address equals zero.

To have more than one device per loop, wire the 
devices in parallel and placed into �Multidrop� 
mode. This mode is enabled by changing the 
address from zero to any address between
1 � 15. After the mode is enabled, the analog 
output of each device is fixed and no longer 
represents any variable.
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To change the polling option:
1. From the HART main menu, double-tap Utility.
2. Double-tap Configure HART Application.
3. Double-tap Polling.
4. Select one of the following polling options:
� Never Poll - Connects to a device at address 0 

and if not found, it will not poll.
� Ask Before Polling - Connects to a device at 

address 0 and if not found, you will be asked if 
you want the communicator to poll for devices at 
addresses 1�15.

� Always Poll - Connects to a device at address 0 
and if not found, the communicator will 
automatically poll for devices at addresses 1�15.

� Digital Poll - Polls addresses 0�15, regardless if 
a device is found at address 0. To find individual 
device addresses, use this option to find each 
connected device in the loop and list them by tag 
number.

� Poll Using Tag - Allows you to enter the tag of 
the device. You will be prompted to enter a tag 
name upon starting the HART Application.

� Poll Using Long Tag - Allows you to enter the 
long tag of the device. You will be prompted to 
enter a tag name upon starting the HART 
Application. (Only supported in HART Universal 
revision 6 devices.) Double-tap when the tag is 
truncated to display the full tag. 

5. Tap Enter.
Refer to your device-specific manual for 
information about changing a device polling 
address.
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Changing ignored status messages
The 375 Field Communicator displays status 
messages from all connected HART devices. The 
Ignore Status option lets you specify the number of 
field device status messages that are ignored, 
extending the time between displayed messages. 
The default is 50 messages. If you choose to 
ignore all field device status messages, every 
message from nuisance to critical will be ignored. 

To change the number of ignored status 
messages:
1. From the HART main menu, double-tap Utility.
2. Double-tap Configure HART Application.
3. Double-tap Ignore Status.
4. Enter the number of status messages you want 

ignored before the next message is displayed. 
You can specify a number from 50 to 500.

5. Tap ENTER. All field device status messages 
will be ignored until the quantity specified has 
been reached.

Storage Cleanup
The Storage Cleanup menu lets you delete the 
following items:
� Internal Flash - By selecting YES you will 

remove all configurations saved in the Internal 
Flash.

� Configuration Expansion Module - By 
selecting YES you will remove all configurations 
saved in the Configuration Expansion Module. 

� Hot Key Menu - By selecting YES you will 
delete all items from the Hot Key menu. 
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Viewing 
available 
Device 
Descriptions

HART Device Descriptions enable the 375 Field 
Communicator to recognize and configure specific 
HART-compatible devices. To view the currently 
installed HART Device Descriptions:
1. From the HART main menu, double-tap Utility.
2. Double-tap Available Device Descriptions. 

The manufacturers with device descriptions 
installed on the 375 Field Communicator are 
listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

Simulating an 
online 
connection to 
a HART device

The 375 Field Communicator has a simulation 
mode that allows you to simulate an online 
connection to a HART-compatible device without 
actually connecting to a device. Simulation mode is 
a training tool that helps you become familiar with 
devices before configuring them in a critical 
environment. A simulated configuration cannot be 
saved. 

To simulate a connection to a HART device:
1. From the HART main menu, double-tap Utility.
2. Double-tap Simulation. The manufacturers with 

device descriptions installed on the 375 Field 
Communicator are listed.

3. Double-tap the desired manufacturer to expand 
the list. The models available for the 
manufacturer are listed.

4. Double-tap the desired model to expand the list. 
The device revisions available for the selected 
model are listed.

5. Double-tap the desired device revision. Refer to 
the device manual to determine the device 
revision.
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6. If a warning appears, thoroughly read the 
warning, tap CONT. to accept the warning and 
proceed, or tap EXIT to end creating a new unit 
configuration. (This warning will not appear if 
your device is tested.) The online menu for the 
simulated device is displayed. You can now use 
the 375 Field Communicator as if it were 
connected to the selected device and perform 
any online task. 

Viewing HART 
diagnostics

DC voltage measurement (HART terminals)
To check the device voltage:
1. From the HART main menu, double-tap Utility.
2. Double-tap HART Diagnostics.
3. Double-tap DC Voltage Measurement. The DC 

voltage measurement is displayed. Tap OK 
when done viewing the measurement. Exit the 
HART Terminal Voltage menu and re-enter to 
refresh the screen. Voltage measurements are 
for reference purposes only.

Disconnecting 
from a HART 
device

Prior to disconnecting be sure to check the 
following items:
� Determine if you want to save as a configuration.
� Verify methods (e.g. calibration, loop test) are 

complete.
� Resolve any un-sent data to the device. 
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SECTION 4 TROUBLESHOOTING
OVERVIEW This section provides basic troubleshooting 
techniques for the Model 375 Field Communicator. 

Below are methods for troubleshooting HART 
Networks that are experiencing problems 
communicating between a field device and the 375 
Field Communicator.

Troubleshooting 
suggestions

Answer the questions below and use the 
troubleshooting table, Table 4-4,before calling 
technical support personnel.
� Does the control system have HART 

communication capabilities? 
� Is it configured to communicate HART currently? 

If so, is it reporting communication problems? 

If not, stop HART communications on the control 
system and test communication with the 375 
Field Communicator again. 

� Is there a barrier installed?
� Is the barrier capable of passing along the HART 

signal?
www.fieldcommunicator.com
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Loops
Verify the HART loop current and voltage on the 
Field device. Almost all field devices need at least 
4mA and 12VDC to operate properly.
If there are multiple field devices on a multidrop 
loop then set the 375 Field Communicator to digital 
polling mode.

Inspection of the loop wiring can often times reveal 
problems. The shield is normally grounded at one 
end only, which is usually the control system. 

Verify that the loop has a minimum of 250 ohms 
resistance. If there is not an external resistor, then 
normally, the total resistance is the resistance of 
the process-indicating device monitoring the loop. 
Check the manuals for the process-indicating 
device to determine it's loop resistance. If the 
resistance of the process-indicating device is 
unknown it can be determined by knowing the 
current flow in the loop and the voltage across the 
process-indicating device. 

The resistance can be calculated using the 
formula, Resistance = Voltage / Current. The 375 
Field Communicator can be used to measure the 
voltage, see �DC voltage measurement (HART 
terminals)� on page 3-22.

Sample values
Loop Current Flow Minimum voltage for 250 ohms.
4 ma 1 Volt
8 ma 2 Volts
12 ma 3 Volts
16 ma 4 Volts 
20 ma 5 Volts
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If the voltage across the process-indicating device 
is greater than the value listed for a given current 
flow then the device has at least 250 of internal 
resistance. If the voltage is less than the value 
listed on the table for the given current flow, then 
more resistance needs to be added to the loop. 

If an oscilloscope is available for use then use it to 
look for noise on the loop. It is necessary to use a 
scope with differential mode capability to avoid 
grounding one side of the loop. Noise with a 
frequency of 800 Hz to 3300 Hz is of particular 
interest, as this represents frequencies near the 
HART frequencies of 1200 and 2200 Hz.
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Table 4-1.  Troubleshooting table for HART protocol

Symptom Possible Causes Solution
Intermittent communication Insufficient loop 

current and voltage at 
the field device 
terminals.

Verify that there is at least 4mA and 12V DC 
at the field device terminals, see �DC 
voltage measurement (HART terminals)� on 
page 3-22.

Noise on the field loop

Noise or signal 
distortion from the 
control system (i.e. 
noise from the power 
supply powering field 
devices or front end 
analog circuitry inside 
of control system may 
be distorting the HART 
signal.

Poor wiring Check wiring terminations and exposed 
signal wire for damage.

No communication with 
field device

Insufficient loop 
resistance at the HART 
frequencies.

Add an additional 250 ohm resistor in series 
in the loop. Place the leads across the 
resistor and verify if communication has 
been restored.

Insufficient loop 
current and voltage at 
the field device 
terminals.

Verify that there is at least 4mA and 12V DC 
at the field device terminals, see �DC 
voltage measurement (HART terminals)� on 
page 3-22.

Field device may be 
set to HART address 
other than zero 
(multi-drop mode). 

Change Polling mode to something other 
than never poll, e.g. Digital Poll.

Control system is 
communicating HART, but 
the 375 is not 
communicating properly. 

HART communication 
is being prevented by 
the control system.

Stop HART communications on the control 
system and verify if communication between 
the field devices and the communicator is 
restored.
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ERROR AND 
STATUS 
MESSAGES

General Error Messages Description
License file check failed - error code x. Please contact 
service center to resolve this problem. 
Press OK to turn off. (Where x indicates the test that 
failed.)

License file check failed during 
power- up

Battery power is less than 5%. You must recharge the 375 
battery, switch to a spare battery pack, or use external 
power. Press OK to turn off.

The power-up battery check detects 
the battery charge is below five 
percent while on battery.

Battery power is less than 20%. You may need to recharge 
the 375 battery, switch to a spare battery pack, or use 
external power.

The power-up battery check detects 
the battery charge is below 20%, and 
more than or equal to 5% while on 
battery.

Communication circuit is not responding. CDC is not responding during the 
power-up

Warning: System incompatibility detected - error code x.
You may start Listen for PC mode and use the 375 
Programming Utility to resolve this. Or
You may turn off your 375 and contact service center to 
resolve this. (Where x is an error code indicating what the 
incompatibility detected was or related errors.)

Hardware version or Operating 
System is not compatible.

Installation file is corrupt - error code x. Please call service 
center to resolve this problem. Press OK to turn off. 
(Where x is an error code indicating which cab file size is 
bad, getting file size failure (which means file is missing), 
TAZrev.xml file checksum failure, or other related errors.)

The .cab files size check or 
TAZrev.xml checksum check failed 
before it attempted to launch the 
program loader.

The 375 needs to update its software. Battery power must 
be more than 20% to allow for this update. You must 
recharge the 375 battery, switch to a spare battery pack, or 
use external power. Press OK to turn off. 

This message occurs when on 
battery, and the battery percentage is 
less than 20% before attempting to 
launch program loader:

This 375 is not licensed for HART. You are not licensed for HART 
functionality.

This 375 is not licensed for FOUNDATION Fieldbus. You are not licensed for FOUNDATION 
fieldbus functionality.

The 375 does not detect a System Card. Please make sure 
your System Card is properly installed in its slot. Press OK 
to turn off. 

This message occurs when the 
System Card is not properly installed 
in its slot.

HART Error and Help Messages Description
"Poll Using Long Tag" allows the user to enter the long tag 
of the device they want to connect to

This is a help message.

"Poll Using Tag" allows you to enter the tag of the device 
you want to connect to

This is a help message.

Enter Device Long Tag This is a help message.

Enter the long tag that corresponds to the device you want 
to connect to

This is a help message.

Hart Application Error... �hc.ddl device revision x not 
found.�...Refresh System Card...See User's Manual and 
Programming Interface for details

This error message appears when an 
expected version of hc.ddl is not 
found.



Troubleshooting4-6
Hart Application Error... �registry failure�...Reinstall System 
Files...See User's Manual for details

This error message appears when 
the information describing the 
location of the DD's is not found in 
the registry.

Voltage is currently detected at the Fieldbus Terminals. 
Reconfigure unit and try again.

This error message appears when 
the HART app found voltage on the 
FF connector during initialization and 
during reconnection to a device.

CDC Error...�failure while switching to HART�...Reinstall 
System Files...See Users�s Manual for details

This error message appears when 
the HART app fails to put the CDC in 
HART mode for talking to a HART 
device.

DD Error�"tokenizer mismatch"�DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y...Reinstall DD�see Programming Interface for 
details

This error message appears when 
the version of the tokenizer used to 
tokenize the DD is not what the 
HART app expects.

DD Error�"linker mismatch"...DD version x.y; HART app 
version x.y...Reinstall DD�see Programming Interface for 
details

This error message appears when 
the version of the linker used to link 
the DD is not what the HART app 
expects.

DD Error�"developed-to mismatch"�DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y> �see 
Programming Interface for solution. 

This error message appears when 
the DD was developed and tested 
using a later HART app revision.

Warning: this DD is untested with the current Hart App ver 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>�you may experience unexpected or 
inappropriate results�see Programming Interface for 
details on DD updates�Do you want to accept these risks 
and proceed?

This error message appears when 
the DD was not tested and verified 
with the HART app.

DD Error�"tested-to sequence mismatch"�DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y�see Programming Interface for solution

This error message appears when 
the DD was tested with a previous 
version but not with this version of the 
HART app

DD Error�"developed-to mismatch"...DD version 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y>; HART app 
version x.y...Reinstall DD�see Programming Interface for 
details

This error message appears when 
the DD was developed using a later 
HART app revision.

DD Error�"DD header file corrupted"...Reinstall Device 
version <manufacture name, device name, dev. rev. #, and 
DD rev. #>; HART application <version x.y> �see 
Programming Interface for details

This error message appears when 
there is a check sum error in the DD 
header file.

Hart Application Error�"data compression dll is 
missing"�Reinstall System Files...See User's Manual for 
details

This error message appears when 
the data compression component 
can not be located.

Hart Application Error�"data compression dll is 
corrupted"�Reinstall System Files...See User's Manual for 
details

This error message appears when a 
required functionality is missing from 
the data compression component.

Memory Error�"data compression memory allocation 
error"�Restart Unit...See User's Manual for further details

This error message appears when 
HART app is unable to acquire 
enough memory for data 
compression.
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DD Error�"failure while opening DD"...Reinstall Device 
Type x Device Rev x dd Rev x�see Programming 
Interface for details

This error message appears when 
the system can not open the DD file.

DD Error�"failure while uncompressing DD"...Reinstall 
Device revision <manufacture name, device name, dev. 
rev. #, and DD rev. #> �see Programming Interface for 
details

This error message appears when an 
error is detected while 
uncompressing the DD.

Communication Error�"unexpected return value"�See 
User's Manual for solution

This error message appears when an 
expected value returned from a 
function call.

DD Error�"DD file corrupted"...Reinstall Device revision 
<manufacture name, device name, dev. rev. #, and 
DD rev. #>�see Programming Interface for details

This error message appears when 
the checksum of the DD does not 
match with that described in the DD 
header file.

Forward Compatibility Blocked�DD Device Type x Device 
Rev x dd Rev x cannot be used in forward compatibility 
mode�x� Do you wish to proceed in forward compatibility 
mode?

This error message appears when 
the HART app attempts to use a DD 
to run in forward compatibility mode 
and finds that the DD is prevented 
from running in forward compatibility 
mode

DD Not Installed�DD device type x device rev x is not 
installed on the System Card�see Programming Interface 
for details on DD updates�Do you wish to proceed in 
forward compatibility mode?

This error message appears when 
the DD for the connected device is 
not in the unit.
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REQUIRED 
INFORMATION 
FOR 
TECHNICAL 
ASSISTANCE 

Before you call for technical support personnel, 
have the following information and answers to the 
following questions ready.
� Manufacturer and model of Control System (as 

applicable)
� 375 Field Communicator software revision
� Manufacturer and model revision of field device
� Loop diagram of the problem loop
� Plant layout diagram(s). What is the proximity to 

other equipment?
� Does HART Communication work when certain 

devices or processes are not running?
� What is the total cable length run from the 

termination panel to the Field device?
� What is the message on the 375 Field 

Communicator when attempting to communicate 
with a field device? (i.e. device not found)

� How many HART loops are there in the facility?
� How many HART loops are failing (i.e. no 

communication)?
� How much resistance (Ohms) is in the HART 

loop?
� User�s Manual for the field device

Contacting Technical Support Personnel
Contact your supplier or go to the website, 
www.fieldcommunicator.com, for a list of technical 
support locations.
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APPENDIX A REFERENCE INFORMATION
PROCESSOR 
AND MEMORY 
SPECIFICATIONS

Microprocessor 133 Mhz Hitachi® SH3

Memory Internal Flash 
32 MB

System Card
128 MB (or higher) Secure Digital card

RAM
32 MB

Expansion Module
32 MB (or higher) Secure Digital card

PHYSICAL 
SPECIFICATIONS

Weight Approximately 2 lb. (950 grams) with battery

Display 1/4 VGA (240 by 320 pixels) monochrome touch 
screen with a viewing area of approximately 9 cm 
by 12 cm (14.8 cm diagonal)
Base glass thickness 1.1 mm anti-glare
Dimensions 85.5 mm x 54.0 mm x 8.26 mm
www.fieldcommunicator.com
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Keypad Twenty-five keys including four action keys, twelve 
alphanumeric keys, four alternate functionality 
keys, on/off, and 4 navigation (arrow) keys; 
membrane design with tactile feedback

POWER 
SUPPLY 
SPECIFICATIONS

Power supply voltage
6.0 V

Battery
Five rechargeable NiMh AA batteries
Sealed for Intrinsic Safety purposes. 
Not customer serviceable.

Battery operating time
Ten hours typical use

Battery Charger 
110/120 vAC, 60 Hz, U.S. plug
220/240 vAC, 50 Hz, European plug
220/240 vAC, 50 Hz, U.K. plug

CONNECTION 
SPECIFICATIONS

Battery Charger
2.5 mm jack

HART and Fieldbus Communication
Three 4mm banana plugs (One common to both 
HART and FOUNDATION fieldbus.)

Personal Computer
IrDA port supporting up to 115 Kb/s
± 15 degrees recommended maximum angle from 
center line.
18 in. recommended maximum distance from 
center line.
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ENVIRONMENTAL 
SPECIFICATIONS

Usage
-10°C to +50°C 
0% to 95%RH (non condensing) for 0°C to +50°C 

Charge
0°C to +40°C

Storage
-20°C to +55°C with batteries 
(less than one month)

Storage without batteries
-20°C to +60°C 

Enclosure rating
IP51 (front)

Shock
Will survive a 1-meter drop test onto concrete

ORDERING 
INFORMATION

Up-to-date ordering and spare part information can 
be found on the 375 Field Communicator website, 
www.fieldcommunicator.com.
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APPENDIX B APPROVAL INFORMATION
OVERVIEW This Appendix contains information on approved 
manufacturing locations, the European Directive, 
Hazardous Locations Certifications, and approval 
drawings for HART protocol.

APPROVED 
MANUFACTURING 
LOCATIONS

Emerson Process Management �
Leicester, England

EUROPEAN 
DIRECTIVE 
INFORMATION

Equipment and 
componet 
directive 
(94/9/EC)

Emerson Process Management complies with the 
ATEX Directive. Specific ATEX Directive 
Information is located within this appendix.
CE Compliance per EN 50014, EN 50020, and 
EN 50284

Electro 
Magnetic 
Compatibility 
(89/336/EWG)

Tested to specifications EN 61000-6-3 and 
EN 61000-6-2

Other 
important 
guidelines

Only use new, original parts. 
Do not charge the battery in hazardous areas.
Have repairs done only by qualified personnel.
Only charge or power using the 375 Power Supply.
www.fieldcommunicator.com
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HAZARDOUS 
LOCATIONS 
CERTIFICATIONS

North 
American 
Certifications

Factory Mutual (FM)
Approval pending. Intrinsically Safe for Class I, 
Division 1, Groups A, B, C, and D. Non-Incendive 
for Class I, Division 2, Groups A, B, C, and D.

Figure B - 1.  FM Intrinsically Safe Configuration (Ungrounded) 

Figure B - 2.  FM Intrinsically Safe Configuration (Grounded)
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Canadian Standards Association (CSA)
Approval pending. Intrinsically safe for use in Class 
1, Division 1, Groups A, B, C, and D hazardous 
locations when connected to CSA-certified intrinsic 
safety barriers as indicated the control drawing.

European 
Certifications

CENELEC Intrinsic Safety
Certification No.: DMT 03 ATEX E 031

 II 2 G (1 GD) 
EEx ia IIC T4 
(Tamb = -10 °C to +50 °C) 

HART Intrinsically Safe electrical parameters

Special conditions for safe use:
The intrinsically safe bus circuits type of protection 
EEx ia II can be connected to apparatus which are 
located in area where combustible dust can be 
present. It must be sure, that only apparatus may 
be connected to those circuits which are designed 
and certified for use in category 1D or 2D. 

Input Parameters
Ui = 30 Volt DC
Ii = 200 mA
Pi = 1.0 Watt
Li = 0
Ci = 0
Output Parameters

U0 = 0.4 Volt DC
I0 = 0.3 nA
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GLOSSARY
Alphanumeric
A character set that contains both letters and digits and, usually, other 
characters, such as punctuation marks. 

AMS
A suite of software for remotely managing SMART® field devices 
over existing HART or FOUNDATION fieldbus networks. You can use 
AMS to monitor devices, configure devices, maintain calibration 
results, run diagnostic routines, and maintain historical data.

CDC
Communication Diagnostic Circuitry

CENELEC
European Committee for Electrotechnical Standardization

Device configuration
Parameters that define the physical attributes and operating 
characteristics of a device.

Device Description (DD)
A set of instructions written in the HART or FOUNDATION fieldbus 
Device Description Language that defines the parameters and 
commands that a host application needs to communicate with a 
HART or FOUNDATION fieldbus field device.
www.fieldcommunicator.com
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DDL
Device Description Language. A specialized programming language 
used to write Device Descriptions for HART or FOUNDATION fieldbus 
-compatible field devices. See also Device Description. 

Expansion Module (EM)
An optional removable memory card that snaps into the Expansion 
Port on the side of the 375 Field Communicator. See ordering 
information for availability types.

Field device
Field devices may generate or receive an analog signal in addition to 
the HART digital communication signal.

Fieldbus Foundation
The organization that develops and supports FOUNDATION fieldbus, 
an international, interoperable standard for communication of process 
automation and control information. Members include suppliers and 
end users of process control and manufacturing automation products. 
Support for the standard includes education, interoperability and 
conformance testing, testing tools, and development software.

Internal Flash
The memory that stores the OS, an application software that also 
stores twenty-five HART device configurations, HART event 
captures, fieldbus statistics, and user generated text files.

Intrinsic Safety
The concept of Components device whereby the device is designed 
to limit the amount of energy consumed or provided to field devices to 
levels below those that are required to ignite specific types of 
hazardous materials under fault and no fault conditions. 

FOUNDATION fieldbus 
Foundation Fieldbus is a specific fieldbus technology developed and 
supported by Emerson Process Management and the other members 
of the independent Fieldbus Foundation. Foundation Fieldbus 
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technology uses Device Descriptions and function blocks to enable 
intelligent field devices to execute control functions traditionally 
performed by a distributed control system. 

HART device
A device that communicates information using the HART protocol.

HART loop
A communication network in which the master and slave device are 
HART-smart or HART-compatible.

HART protocol
Highway Addressable Remote Transducer communication protocol. 
An industry-standard protocol for digitally enhanced 4�20 mA 
communication with �smart� field devices.

HART tag
An 8-character field used to identify a device. A 32-character long tag 
is also possible with HART Universal revision 6 device. This field is 
stored in the HART device and can be modified.

Intrinsic Safety (IS)
A method of providing safe operation of electronic process-control 
instrumentation in hazardous areas, such as flammable 
environments. IS systems keep the available electrical energy in the 
system low enough that ignition of the hazardous atmosphere cannot 
occur.

Intrinsic Safety barrier
A physical entity that limits the current and voltage into a hazardous 
area in order to satisfy Intrinsic Safety requirements.

IrDA
Infrared Data Association, a non-profit trade association that 
establishes standards for infrared communications between devices 
such as personal computers, printers, and handheld devices.



G-iv
Personal Computer (PC)
Synonymous with microcomputer, a computer that serves one user in 
the office or the home. PCs are the largest installed base of personal 
computers. Macintosh is second.

Polling
A method of sequentially interrogating a network to determine which 
devices are present.

Process variable (PV)
A process parameter that is being measured or controlled (for 
example, level, flow, temperature, mass, or density).

Segment (Fieldbus only)
The section of a Fieldbus that is terminated in its characteristic 
impedance. Segments are linked by repeaters to form a complete 
Fieldbus.

System Card
An internal Secure Digital Card with non-volatile Flash memory. A 
copy of installable 375 Field Communicator application software 
exists on every SC. The SC memory also stores all HART and 
FOUNDATION fieldbus Device Descriptions.

User data file
A text (.TXT) file created by a user either on a PC or with the 
ScratchPad application on the 375. User data files can be transferred 
between the 375 Programming Utility and a 375.
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INDEX
Symbols
.rec files 2-11
.txt file G-iv
.txt files 2-16

Numerics
375 Main Menu 2-9

A
About 375 2-10
Alphanumeric keypad 2-5, 2-7
AMS 2-14, G-i
Analog output 3-18
Approval information B-1
Arrow

Back 2-9
ATEX B-1

B
Back arrow 2-9
Backlight 2-10

Key 2-5, 2-7
Basic

Features 2-5, 3-2
Functions 2-5, 3-2

Basic Setup 3-16
Battery 2-21

Charge 2-12, 2-21, 2-22
Charger A-2
Indicator button 2-2

Operating time A-2
Pack 2-2
Specifications A-2

Battery pack 2-22

Brightness, see Backlight
 2-10

Button
FILTR 3-7
Home 3-15
Hot Key 3-3
Terminate 2-9
XPAND 3-8

C
Calibration 3-16
Canadian Standards Association B-3
CDC G-i
CENELEC Intrinsic Safety B-3, G-i
Charge A-3
Charger 2-22

Battery A-2
Connection 2-5

Cleanup 3-20
Clock 2-11
Communication 2-14

Terminals 2-5
Communication and Diagnostic Circuitry
(CDC) 2-10
Comparing

HART configurations offline 3-10
Components 2-5
Configuration

Comparing 3-10
Copying 3-9
Creating new 3-5
Deleting 3-9
HART offline 3-8
www.fieldcommunicator.com
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Offline configurations 3-5
Opening 3-7
Renaming 3-10

Connecting
Load resistor 3-14
Power supply/charger 2-5
Specifications A-2

Contrast 2-11
Copying

HART configurations offline 3-9
Copying text 2-18
Cutting text 2-18

D
D/A trim 3-16
Damping 3-16
Date/Time 2-11
DDL G-ii
Deleting 2-19

Document 2-19
HART configurations offline 3-9

Detailed Setup 3-17
Device

Configuration 2-20, G-i, G-ii
Description 2-15, G-i, G-iv
Descriptions 3-21
Setup 3-16

Device descriptions 2-20
Diagnostics and Service 3-16
Disconnecting

HART 3-22
Display A-1
Display, see Touch screen 2-5
Document 2-17

Deleting 2-19
Opening 2-19

E
Easy Upgrade 2-15
Edit

HART configurations offline 3-8
Electro Magnetic Compatibility B-1
Enclosure rating A-3
Enter key 2-5, 2-6
Entering text 2-17
Environmental specifications A-3
Equipment and componet directive B-1

Error 4-5
European Certifications B-3
European Directive Information B-1
Event capture 2-11, 2-20, G-ii
Exiting

ScratchPad 2-19
Expansion Module 2-20, 3-20, A-1, G-ii
Expansion port 2-5

F
Factory Mutual B-2
Fast key 3-2
Features 2-5, 3-2
Field device G-ii
Fieldbus 1-2
Fieldbus Foundation G-ii
File

Management 2-20
Transferring 2-15

Filter
Sort 3-7
Tag 3-7

FILTR button 3-7
Flash, see Internal Flash 2-20
Foundation fieldbus 1-2, 2-12, G-ii
Function key 2-5, 2-8
Functions 2-5, 3-2

H
HART

Application 3-14
Comparing offline 3-10
Copying offline 3-9
Deleting offline 3-9
Disconnecting 3-22
Editing offline 3-8
Functionality 3-1
Icon 3-2
Load resistor 3-14
Loop 3-13, G-iii
New configuration 3-5
Offline 3-5
Open configurations 3-7
Polling 3-18
Protocol G-iii
Renaming offline 3-10
Simulation 3-21
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Starting application 3-2
Tag G-iii
Utility 3-18

HART Application
Running 2-10

HART device G-iii
HART loop

Connecting 3-11
Terminals 3-12

Hazardous Locations Certifications B-2
CENELEC B-3
CSA B-3
FM B-2

Home button 3-15
Hot Key 3-3

Cleanup 3-20

I
Ignored status 3-20
Installation

Battery Pack 2-2
System Card 2-2

Internal Flash 3-20, A-1, G-ii
Intrinsic Safety G-ii
Intrinsic safety G-iii

Barrier G-iii
Introduction 1-1
IrDA 2-14, 2-15, G-iii

Adapter 2-14
IrDA interface 2-5

K
Key

Alphanumeric Keypad 2-7
Alphanumeric keypad 2-5, A-2
Backlight 2-5, 2-7
Enter 2-5, 2-6
Fast key sequences 3-2
Function 2-5, 2-8
Hot Key Options 3-3
Keyboard, see Soft Input Panel 2-9
Navigation 2-5, 2-6
On/off 2-5, 2-6
Tab 2-5, 2-6

Keypad 2-5
Keypad, see Alphanumeric keypad 2-6

L
LED 2-5, 2-8, 2-13
License 2-12

AMS 2-15
Listen for PC 2-14
Load resistor 3-14
Loop

HART 3-13, G-iii
Troubleshooting 4-2

Loop test 3-16
Lower range value 3-18

M
Maintenance 2-21
Managing files 2-20
Manufacturing locations B-1
Memory 2-12, 2-20

Specifications A-1
Menu trees 3-1
Messages

Error 4-5
Safety 2-1, 3-1
Status messages 4-5

Modes
Listen for PC 2-14

Multifunction LED 2-5, 2-8, 2-13

N
Navigation keys 2-5, 2-6
New document 2-17
North American Certifications B-2

O
Offline

HART 3-5
On/off key 2-5, 2-6
Online 3-11

Menu 3-14
Simulation 3-21

Opening
Document 2-17, 2-19
Saved configurations 3-7

Operating system 2-10
Ordering information A-3
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Polling 3-18, G-iv
Power 2-12

Supply 2-5, 2-22
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Voltage A-2

Primary variable 3-17
Process variable G-iv
Process variables 3-16
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Processor specifications A-1
Programming Utility 2-12, 2-14, 2-15
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R
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Installation 2-2
System software 2-10
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Tag 3-16, 3-17

filter 3-7
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Terminate button 2-9
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